You can read the recommendations in the user guide, the technical guide or the installation guide for HP OFFICEJET 4630. You'll
find the answers to all your questions on the HP OFFICEJET 4630 in the user manual (information, specifications, safety advice,
size, accessories, etc.). Detailed instructions for use are in the User's Guide.
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Manual abstract:
34 Tips for copy success . 35 Tips for scan success . 55 Tips for fax success . 72 Tips for working with cartridges . 80 Connect wirelessly to the printer without
a router . 81 Tips for setting up and using a networked printer . @@@@@@ wireless status light: Blue light indicates wireless connection. @@Press and
hold down the button until light blinks to start Wi-Fi Protected Setup (WPS) push button mode. Keypad: Use the keypad to enter numbers and text. back:
Returns to the previous screen.
Selection button: The function of this button changes depending on what is displayed on the printer display. oK: Confirms the current selection. Down button:
Use this button to navigate menus and select number of copies. Help: On the Home screen, shows all Help topics. On another screen, shows information or
animation on the display to assist in the current operation.
EPrint button: Press the button to display the Web Services Settings menu where you can view the printer's email address and make ePrint settings. figure 2-2
On button light Light behavior Off Solution The printer is powered off. 6 Chapter 2 Get to know the HP Officejet 4630 series ENWW Light behavior Dimmed
Fast blinking Pulsing On Solution Indicates the printer is in Sleep mode. The printer automatically enters Sleep mode after 5 minutes of inactivity. error has
occurred.
Refer to the messages on the printer display. Indicates that the printer is initializing or is being shut down. The printer is printing, scanning, copying, or is on
and ready to print. figure 2-3 Wireless status light Light behavior Off Slow blinking Fast blinking On Solution Wireless is off. Press the Wireless button to
access the wireless menu on the printer display. If the connection cannot be established, make sure the printer is within the range of wireless signal. a
wireless error has occurred. Refer to the messages on the printer display. wireless connection has been established and you can print. ENWW Control panel
and status lights 7 Wireless settings Press the Wireless button to view wireless status and menu options.
Â â â If the printer has an active connection to a wireless network, the wireless light is on solid blue and the printer display shows Connected and
the printer IP address. If wireless is turned off, the wireless light is off and the display screen shows Wireless Off. If wireless is enabled (wireless radio on)
and a wireless connection has not been established, the wireless light is blinking and the display screen shows Connecting or Not Connected. You can use the
printer display to retrieve information about your wireless network, establish a wireless connection, and more. The network configuration page displays the
network status, hostname, network name, and more. The wireless network test report displays the diagnostics results for the status of the wireless network,
wireless signal strength, detected networks, and more. Press the Wireless button to access the Wireless Status menu. Press the button next to Settings to access
the Wireless Settings menu. select Print Report , and then select Configuration Page. Press the Wireless button to access the Wireless Status menu.
Press the button next to Settings to access the Wireless Settings menu. select Print Report , and then select Test Report. Press the Wireless button to access the
Wireless Status menu. Press the button next to Settings to access the Wireless Settings menu. Press the Wireless button to access the Wireless Settings menu.
For more information, see Wi-Fi Protected Setup (WPS â requires WPS router) on page 76. For more information, see Traditional wireless connection
(requires router) on page 77. 8 Chapter 2 Get to know the HP Officejet 4630 series ENWW 3 Print â â â â â â â Print documents
Print photos Print envelopes Print Quick Forms Print with HP wireless direct Print using the maximum dpi Tips for print success ENWW 9 Print documents
To load paper 1. Make sure the paper tray is open. Slide the paper-width guides all the way open.
Place the paper in the paper tray. The side to be printed on should face down. Push the stack of paper into the printer until it stops. Slide the paper-width
guides firmly against the edge of the paper. On the File menu in your software, click Print. Make sure your printer is selected. Click the button that opens the
Properties dialog box. Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer Properties, Printer, or
Preferences. Â On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the Tray Selection area, and then select the
appropriate print quality in the Quality Settings area. Click the Advanced button, in the Paper/Output area, select the appropriate paper size from the Paper
Size drop-down list.
Â For more printing options, see Tips for print success on page 18. To print on both sides of the page 1. 2. On the File menu in your software, click Print.
Make sure your printer is selected. 10 Chapter 3 Print ENWW 3. Click the button that opens the Properties dialog box. Depending on your software
application, this button might be called Properties, Options, Printer Setup, Printer Properties, Printer, or Preferences. Â On the Paper/Quality tab, select
the appropriate paper type from the Media drop-down list in the Tray Selection area, and then select the appropriate print quality in the Quality Settings
area. Click the Advanced button, in the Paper/Output area, select the appropriate paper size from the Paper Size drop-down list.
Â For more printing options, see Tips for print success on page 18. On the Layout tab, select Flip on Long Edge or Flip on Short Edge from the Print on
Both Sides drop-down list. click OK to print. NOTE: After one page of the document is printed, you are prompted to wait for a few seconds. Then the printer
automatically reloads the paper back to print on the other side.
You do not need to manually reload the paper. ENWW Print documents 11 Print photos To load photo paper 1. Make sure the paper tray is open. Slide the
paper-width guides all the way open. Remove all paper from the paper tray, and then load the photo paper with side to be printed on facing down.
Push the stack of photo papers into the printer until it stops. Slide the paper-width guides firmly against the edge of the photo papers. On the File menu in
your software, click Print. Make sure your printer is selected. Click the button that opens the Properties dialog box. Depending on your software application,
this button might be called Properties, Options, Printer Setup, Printer Properties, Printer, or Preferences. Â On the Paper/Quality tab, select the
appropriate paper type from the Media drop-down list in the Tray Selection area, and then select the appropriate print quality in the Quality Settings area.
Click Advanced to select the appropriate paper size from the Paper Size drop-down list.
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Â For more printing options, see Tips for print success on page 18. NOTE: For maximum dpi resolution, go to Paper/Quality tab, select Photo Paper
from the Media drop-down list, and then select Best in the Quality Settings area.
Then click the Advanced button and select Yes from the Print in Max DPI drop-down list. If you want to print max DPI in grayscale, select High Quality
Grayscale from the Print in Grayscale drop-down list. Click OK to return to the Properties dialog box. Click OK, and then click Print or OK in the Print
dialog box. NOTE: After the printing is finished, remove unused photo paper from the paper tray. Store the photo paper so it does not start to curl, which
could reduce the quality of your printout. 12 Chapter 3 Print ENWW Print envelopes You can load one or more envelopes into the paper tray of the HP
Officejet 4630 series. Do not use shiny or embossed envelopes, or envelopes that have clasps or windows. Make sure the paper tray is open. Slide the paperwidth guides all the way open.
Place the envelopes in the center of the paper tray. The side to be printed on should face down. The flap should be on the left side. Push the stack of envelopes
into the printer until it stops. Slide the paper-width guides firmly against the edge of the envelopes.
For details on how to format on envelopes, see the help files in your word application. On the File menu in your software, click Print. Make sure your printer
is selected. Click the button that opens the Properties dialog box. Depending on your software application, this button might be called Properties, Options,
Printer Setup, Printer Properties, Printer, or Preferences.
Â On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the Tray Selection area, and then select the appropriate
print quality in the Quality Settings area. Click Advanced to select the appropriate paper size from the Paper Size drop-down list. Â For more printing
options, see Tips for print success on page 18. 5. Click OK, and then click Print or OK in the Print dialog box. ENWW Print envelopes 13 Print Quick Forms
Use Quick Forms to print calendars, check lists, games, notebook paper, graph paper, music paper, and games. to print Quick Forms 1. From the Home
screen on the printer display, press the Up and Down buttons to select Quick Forms, and then press OK. TIP: If the Quick Forms option does not appear on
the printer display, press the Home button, and then press the Up and Down buttons until you see Quick Forms. Press the Up and Down buttons to select one
of the Quick Forms options, and then press OK.
After you have selected the type of form that you want to print, select the number of copies, and then press OK. 14 Chapter 3 Print ENWW Print with HP
wireless direct With HP wireless direct, you can print wirelessly from a computer, smart phone, tablet, or other wireless-capable deviceâwithout
connecting to an existing wireless network. When using HP wireless direct, note the following guidelines: â Make sure your computer or mobile device has
the necessary software. If you are using a computer, make sure you have installed the printer software provided with the printer. Â If you are using a
mobile device, make sure you have installed a compatible printing app. For more information about mobile printing, visit www. Make sure HP wireless direct
is turned on in the printer and, if necessary, security is enabled. For more information, see Connect wirelessly to the printer without a router on page 81. Up
to five computers and mobile devices can use the same HP wireless direct connection. HP wireless direct can be used while the printer is also connected to a
computer using USB cable or to a network using a wireless connection.
HP wireless direct cannot be used to connect a computer, mobile device, or printer to the Internet. Click here to go online for more information. NOTE: At
this time, these websites might not be available in all languages. Â â â â This section contains the following testimated ink levels on page 66.
Â â If the print quality is not acceptable, see Improve print quality on page 92 for more information.
Always turn off the printer with the On button to allow the printer to protect the nozzles. Paper loading tips â â â â Load a stack of paper (not
just one page). All of the paper in the stack should be the same size and type to avoid a paper jam. Load paper with side to be printed on facing down. Ensure
that paper loaded in the paper tray lays flat and the edges are not bent or torn.
Adjust the paper-width guides in the paper tray to fit snugly against all paper. Make sure the paper-width guides do not bend the paper in the paper tray. For
more information, see Load media on page 24. Printer settings tips â To change default print settings, click Print, Scan & Fax, and then click Set
Preferences in the printer software. Depending on your operating system, do one of the following to open the printer software: â¦ â¦ Windows 8: On the
Start screen, right-click an empty area on the screen, click All Apps on the app bar, and then click the icon with the printer's name. Windows 7, Windows
Vista, and Windows XP: From the computer desktop, click Start, select All Programs, click HP, click HP Officejet 4630 series, and then click HP Officejet
4630 series. Â â â To select the number of pages to print per sheet, on the Layout tab, select the appropriate option from the Pages per Sheet dropdown list. If you want to change the page orientation, set it in your application interface. To view more printing settings, on the Layout or Paper/Quality tab,
click the Advanced button to open the Advanced Options dialog box. 18 Chapter 3 Print ENWW â¦ â¦ Print in Grayscale: Allows you to print a black and
white document using the black ink only.
Select Black Ink Only, and then click the OK button. Borderless Printing: Select this feature to print photos without border. Not all media types support this
feature. You will see an alert icon beside the option if the selected media type in the Media drop-down list does not support it. Preserve Layout: This feature
only works with the duplex printing. If the image is larger than the printable area, select this feature to scale the page content to be within the smaller
margins so that extra pages are not created. It places two pages on each side of a sheet that can then be folded into a booklet in half size of the paper. Select a
binding method from the drop-down list, and then click OK. Â â Booklet-LeftBinding: The binding side after folded into a booklet appears at the left
side. Select the option if your reading habit is from left to right.
Booklet-RightBinding: The binding side after folded into a booklet appears at the right side.
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Select the option if your reading habit is from right to left. Â¦ â¦ â¦ NOTE: The preview on the Layout tab cannot reflect what you select from the Booklet
drop-down list. Â¦ Pages per Sheet Layout: Helps you specify the order of the pages if you print document in more than two pages per sheet. NOTE: The
preview on the Layout tab cannot reflect what you select from the Pages per Sheet Layout drop-down list.
Â You can use printing shortcut to save setting time. A printing shortcut stores the setting values that are appropriate for a particular kind of job, so that
you can set all the options with a single click. To use it, go to the Printing Shortcut tab, select one printing shortcut, and then click OK. To add a new printing
shortcut, after making settings on the Layout or Paper/Quality tab, click the Printing Shortcut tab, click Save As and enter a name, and then click OK. to
delete a printing shortcut , select it , and then click Delete.
NOTE: You cannot delete the default printing shortcuts. ENWW Tips for print success 19 Notes â Original HP ink cartridges are designed and tested with
HP printers and papers to help you easily produce great results, time after time. NOTE: HP cannot guarantee the quality or reliability of non-HP supplies.
Product service or repairs required as a result of using a non-HP supply will not be covered under warranty. If you believe you purchased Original HP ink
cartridges, go to www. Â Ink level warnings and indicators provide estimates for planning purposes only. NOTE: When you receive a low-ink warning
message, consider having a replacement cartridge available to avoid possible printing delays. You do not need to replace the cartridges until print quality
becomes unacceptable. Â â Software settings selected in the print driver only apply to printing, they do not apply to copying or scanning. You can print
your document on both sides of the paper.
20 Chapter 3 Print ENWW 4 Paper basics â â â â Recommended papers for printing Load media Load original Order HP paper supplies
ENWW 21 Recommended papers for printing If you want the best print quality, HP recommends using HP papers that are specifically designed for the type of
project you are printing. Depending on your country/region, some of these papers might not be available. ColorLok â HP recommends plain papers with
the ColorLok logo for printing and copying of everyday documents. All papers with the ColorLok logo are independently tested to meet high standards of
reliability and print quality, and produce documents with crisp, vivid color, bolder blacks, and dry faster than ordinary plain papers. Look for papers with the
ColorLok logo in a variety of weights and sizes from major paper manufacturers. Photo printing â HP Premium Plus Photo Paper HP Premium Plus
Photo Paper is HPâs highest-quality photo paper for your best photos. With HP Premium Plus Photo Paper, you can print beautiful photos that are
instant-dry so you can share them right off the printer. it is available in several sizes , including A4 , 8. 5 x 11 inches, 4 x 6 inches (10 x 15 cm), 5 x 7 inches
(13 x 18 cm), and 11 x 17 inches (A3), and in two finishes glossy or soft gloss (semi-gloss). Ideal for framing, displaying, or gifting your best photos and
special photo projects.
hP Premium Plus Photo Paper delivers exceptional results with professional quality and durability. Â HP Advanced Photo Paper This thick photo paper
features an instant-dry finish for easy handling without smudging. it resists water , smears , fingerprints , and humidity. Your prints have a look and feel
comparable to a store-processed photo. Â HP Everyday Photo Paper Print colorful, everyday snapshots at a low cost, using paper designed for casual
photo printing.
This affordable photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper with any inkjet printer. It is available in glossy
finish in several sizes, including A4, 8. 22 Chapter 4 Paper basics ENWW Business documents â HP Premium Presentation Paper 120g Matte or HP
Professional Paper 120 Matt These papers are heavy two-sided matte papers perfect for presentation, proposals, reports, and newsletters. They are heavy
weight for an impressive look and feel.
Â HP Brochure Paper 180g Glossy or HP Professional Paper 180 Glossy These papers are glossy-coated on both sides for two-sided use. They are the
perfect choice for near-photographic reproductions and business graphics for report covers, special presentations, brochures, mailers, and calendars. Â
HP Brochure Paper 180g Matte or HP Professional Paper 180 Matt These papers are matte-coated on both sides for two-sided use. They are the perfect
choice for near-photographic reproductions and business graphics for report covers, special presentations, brochures, mailers, and calendars. everyday
printing â HP Bright White Inkjet Paper HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-sided
color usage with no show-through, which makes it ideal for newsletters, reports, and flyers. It produces documents that look and feel more substantial than
documents printed on standard multipurpose or copy paper. It is suitable for copies, drafts, memos, and other everyday documents. Â HP Office Recycled
Paper HP Office Recycled Paper is a high-quality multifunction paper made with 30% recycled fiber. it features ColorLok Technology for less smearing ,
bolder blacks and vivid colors.
Special projects â HP Iron-On Transfers HP Iron-on Transfers (for light or white fabrics) are the ideal solution for creating custom T-shirts from your
digital photos. ENWW Recommended papers for printing 23 Load media Select a paper size to continue. To load full-size paper 1. Lower the paper tray, and
then pull out the paper tray and tray extender. Â Insert a stack of paper into the paper tray with the short edge forward and the print side down. Â Slide
the stack of paper forward until it stops. 24 Chapter 4 Paper basics ENWW â Adjust the paper-width guides so they fit against both sides of the stack of
paper. â Slide the paper tray in. To load small-size paper 1. Lower the paper tray, and then pull out the paper tray and tray extender.
Â Insert a stack of photo paper into the paper tray with the short edge forward and the print side down. Â â â Slide the stack of photo paper
forward until it stops. Adjust the paper-width guides so they fit against both sides of the stack of photo paper. Lower the paper tray, and then pull out the
paper tray and tray extender. Â Insert one or more envelopes in the center of the paper tray.
The side to be printed on should face down. The flap should be on the left side and facing up.
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Â â â Slide the stack of envelopes forward until it stops. Adjust the paper-width guides so they fit against both sides of the stack of envelopes. slide
the paper tray in.
ENWW Load media 27 Load original You can load your original print-side up in the automatic document feeder or print-side down on the right front corner
of the scanner glass. To load the original in the automatic document feeder 1. Load the original print-side up, head first, in the ADF. 3. Slide the paper-width
guides inward until they stop at the edge of paper. To load the original on the scanner glass 1. Load the original print-side down on the right corner of the
scanner glass. ENWW Load original 29 Order HP paper supplies The printer is designed to work well with most types of office media. Use HP media for
optimum print quality. Com for more information about HP media.
HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All papers with the ColorLok logo are independently
tested to meet high standards of reliability and print quality, and produce documents with crisp, vivid color, bolder blacks and dry faster than ordinary plain
papers. Look for papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers. To purchase HP papers, go to Shop for
Products and Services and select ink, toner and paper. 30 Chapter 4 Paper basics ENWW 5 Copy and scan â â â â Copy documents Scan to a
computer Tips for copy success Tips for scan success ENWW 31 Copy documents The Copy menu on the printer display allows you to easily select number of
copies and color or black and white for copying on plain paper. You can also easily access advanced settings, such as changing the paper type and size,
adjusting the darkness of the copy, and resizing the copy. To make 1-sided black or color copy 1. Load full-size paper in the paper tray. 2. Load the original
print-side up in the ADF or print-side down on the scanner glass.
For more information about loading the original, see Load original on page 28. 3. Select Copy from the Home screen on the printer display to access the copy
menu. If you do not see Copy on the printer display, press the Home button, and then press the Up and Down buttons until you see Copy. From the Copy
menu, select Copies to increase or decrease the number of copies, and then press OK to confirm.
Select Start Black Copy or Start Color Copy, and then press OK to make a black or color copy. To make 2-sided black or color copy 1. Load full-size paper in
the paper tray. 2. Load the first original print-side up in the ADF or print-side down on the scanner glass.
For more information about loading the original, see Load original on page 28. 3. Select Copy from the Home screen on the printer display to access the copy
menu. If you do not see Copy on the printer display, press the Home button, and then press the Up and Down buttons until you see Copy. 4. From the Copy
menu, select Copies to increase or decrease the number of copies, and then press OK to confirm. Â â If you load multiple of 1-sided original in the
ADF, press OK to complete. If you load a 2-sided original in the ADF or on the scanner glass, press OK, and then go to step 7. When the first page finishes,
load the second original print-side up in the ADF or print-side down on the scanner glass. press OK to start copying the second page.
More copy features While in the Copy menu, press the Up and Down buttons to select among settings. Â â Paper Type: Selects paper size and paper
type. A plain paper setting will print in plain paper normal print quality. A photo paper setting will print in photo paper best quality. Resize: Controls the size
of the image or document to be copied. Â¦ â¦ Actual size: Makes a copy that is the same as the size of the original, but the margins of the copied image may
be clipped. Fit to Page: Makes a copy that is centered with a white border around the edges. The resized image is either enlarged or reduced to fit the size of
the selected output paper. NOTE: The scanner glass must be clean to make sure the Fit to Page feature works properly. Â¦ â â Custom Size: Allows
you to increase the size of the image by selecting values greater than 100% or reduce the image size by selecting values less than 100%.
ID Copy: Allows you to copy both sides of ID card. Lighter / Darker: Adjusts the copy settings to make copies lighter or darker. NOTE: After two minutes of
inactivity, the copy options will automatically return to the default settings of plain paper A4 or 8. 5â x 11â (depending on region). ENWW Copy
documents 33 Scan to a computer You can scan from the control panel of the printer or from your computer.
Scan from the control panel if you want to quickly scan one page to an image file. Scan from your computer if you want to scan multiple pages into one file,
define the file format of the scan, or make adjustments to the scanned image. to prepare the scan 1. Load the original print-side up in the ADF or print-side
down on the scanner glass. For more information about loading the original, see Load original on page 28.
Select Scan from the Home screen on the printer display, and then press OK. TIP: If you do not see Scan on the printer display, press the Home button, and
then press the Up and Down buttons until you see Scan. 2. Select the computer that you want to scan to from the printer display, and then press OK. If you do
not see your computer listed on the printer display make sure that your computer is connected to the printer either wirelessly or through a USB cable. If you
have a wireless connection and you have confirmed that the connection is working, you will need to enable wireless scanning in the software. to scan from
your computer 1. Depending on your operating system, do one of the following to open the printer software. Â â Windows 8: On the Start screen, rightclick an empty area on the screen, click All Apps on the app bar, and then click the icon with the printer's name. Windows 7, Windows Vista, and Windows
XP: From the computer desktop, click Start, select All Programs, click HP, click HP Officejet 4630 series, and then click HP Officejet 4630 series.
In the printer software, click the Print, Scan & Fax icon, and then select Scan a Document or Photo. Select the type of scan that you want from the shortcut
menu and then click Scan. NOTE: If Show Scan Preview is selected, you will be able to make adjustments to the scanned image in the preview screen. Select
Save if you want to keep the application open for another scan, or select Done to exit the application. After the scan is saved, a Windows Explorer window
will open in the directory where the scan was saved. NOTE: There is a limited number of computers that can have the scan function activated at the same
time.
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Select Scan on the printer display and you will see the computers that are currently available for scanning. 34 Chapter 5 Copy and scan ENWW Tips for copy
success â â â Clean the scanner glass and make sure that there are no foreign materials adhering to it. To increase or decrease the contrast of your
printed output, select Copy from the printer display and then select Lighter/Darker to adjust the contrast. To select the paper size and paper type of the
printed output, select Copy from the printer display.
From the Copy menu select Paper Type to choose plain or photo paper and photo paper size. To resize the image, select Copy from the printer display and
then select Resize. Â ENWW Tips for copy success 35 Tips for scan success â â â Clean the scanner glass and make sure that there are no
foreign materials adhering to it. After you select Scan from the printer display, choose the computer that you want to scan to from the list of printers on the
printer display. If you have a wireless connection from your printer to your computer, and you want to always be able to quickly scan to your connected
computer, make sure to have Scan to Computer always active.
If you want to scan a document with several pages into one file instead of multiple files, start the scan with the printer software instead of selecting Scan from
the printer display. Â 36 Chapter 5 Copy and scan ENWW 6 Fax You can use the printer to send and receive faxes, including color faxes. You can
schedule faxes to be sent at a later time and set up speed-dials to send faxes quickly and easily to frequently used numbers. From the printer control panel,
you can also set a number of fax options, such as resolution and the contrast between lightness and darkness on the faxes you send. NOTE: Before you begin
faxing, make sure you have set up the printer correctly for faxing.
You might have already done this as part of the initial setup, by using either the control panel or the HP software provided with the printer. You can verify the
fax is set up correctly by running the fax setup test from the control panel. For more information on the fax test, see Test fax setup on page 158. Â â
â â â â â â Send a fax Receive a fax Set up speed-dial entries Change fax settings Fax and digital phone services Fax over Internet
Protocol Use reports Tips for fax success ENWW 37 Send a fax You can send a fax in a variety of ways. Using the printer control panel, you can send a blackandwhite or color fax. You can also send a fax manually from an attached phone. This allows you to speak with the recipient before sending the fax. This
section contains the following topics: â â â â â â Send a standard fax Send a standard fax from the computer Send a fax manually from a
phone Send a fax using monitor dialing Schedule a fax to send later Send a fax in Error Correction Mode Send a standard fax You can easily send a single- or
multiple-page black-and-white or color fax by using the printer control panel. NOTE: If you need printed confirmation that your faxes were successfully sent,
fax confirmation must be enabled. TIP: You can also send a fax manually from a phone or by using monitor dialing.
These features allow you to control the pace of your dialing. They are also useful when you want to use a calling card to charge the call and you have to
respond to tone prompts while dialing. to send a standard fax from the printer control panel 1. Load your original print-side down on the right front corner of
the glass or print-side up in the ADF. For more information about loading the original, see Load original on page 28. From the Home screen on the printer
display, press the Up and Down buttons to select Fax, and then press OK. select Black Fax or Color Fax. If an original is loaded in the ADF, the document is
sent to the number you entered. If no original is detected in the ADF, a message appears that promts you to make a selection. TIP: If the recipient reports
issues with the quality of the fax you sent, you can try changing the resolution or contrast of your fax.
4. Enter the fax number by using the keypad, and then press OK. TIP: To add a pause in the fax number you are entering, press * repeatedly, until a dash (-)
appears on the display. 38 Chapter 6 Fax ENWW Send a standard fax from the computer You can send a document on your computer as a fax, without
printing a copy and faxing it from the printer. NOTE: Faxes sent from your computer by this method use the printer's fax connection, not your Internet
connection or computer modem.
Therefore, make sure the printer is connected to a working telephone line and that the fax function is set up and functioning correctly. To use this feature, you
must install the printer software using the installation program provided on the HP software CD provided with the printer. Open the document on your
computer that you want to fax. On the File menu in your software application, click Print. From the Name list, select the printer that has âfaxâ in the
name.
To change settings (such as selecting to send the document as a black fax or a color fax), click the button that opens the Properties dialog box. Depending on
your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences. After you have changed any settings, click
OK. click Print or OK. Enter the fax number and other information for the recipient, change any further settings for the fax, and then click Send Fax. The
printer begins dialing the fax number and faxing the document. Send a fax manually from a phone Sending a fax manually allows you to make a phone call
and talk with the recipient before you send the fax. This is useful if you want to inform the recipient that you are going to send them a fax before sending it.
When you send a fax manually, you can hear the dial tones, telephone prompts, or other sounds through the handset on your telephone. This makes it easy for
you to use a calling card to send your fax.
Depending on how the recipient has their fax machine set up, the recipient might answer the phone, or the fax machine might take the call. If a person
answers the phone, you can speak with the recipient before sending the fax. If a fax machine answers the call, you can send the fax directly to the fax machine
when you hear the fax tones from the receiving fax machine. To send a fax manually from an extension phone 1. Load your original print-side down on the
right front corner of the glass or print-side up in the ADF. For more information about loading the original, see Load original on page 28. 2. From the Home
screen on the printer display, press the Up and Down buttons to select Fax, and then press OK. eNWW Send a fax 39 3. Dial the number by using the keypad
on the phone that is connected to the printer.
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NOTE: Do not use the keypad on the control panel of the printer when manually sending a fax. You must use the keypad on your phone to dial the recipient's
number. 4. If the recipient answers the telephone, you can engage in a conversation before sending your fax. NOTE: If a fax machine answers the call, you
will hear fax tones from the receiving fax machine.
Proceed to the next step to transmit the fax. 5. When you are ready to send the fax, press OK, select Send New Fax, and then select Black or Color. If you were
speaking with the recipient before sending the fax, inform the recipient that they should press Receive Fax Manually on their fax machine after they hear fax
tones. The telephone line is silent while the fax is transmitting.
At this point, you can hang up the telephone. If you want to continue speaking with the recipient, remain on the line until the fax transmission is complete.
Send a fax using monitor dialing Monitor dialing allows you to dial a number from the printer control panel as you would dial a regular telephone. When you
send a fax using monitor dialing, you can hear the dial tones, telephone prompts, or other sounds through the speakers on the printer. This enables you to
respond to prompts while dialing, as well as control the pace of your dialing. TIP: If you are using a calling card and do not enter your PIN fast enough, the
printer might start sending fax tones too soon and cause your PIN not to be recognized by the calling card service. If this is the case, you can create a speed
dial entry to store the PIN for your calling card. For more information, see Set up speed-dial entries on page 47. NOTE: Make sure the volume is turned on to
hear a dial tone. To send a fax using monitor dialing from the printer control panel 1.
Load your original print-side down on the right front corner of the glass or print-side up in the ADF. For more information about loading the original, see
Load original on page 28. From the Home screen on the printer display, press the Up and Down buttons to select Fax, and then press OK. If the printer
detects an original loaded in the ADF, you can hear a dial tone. If the original is loaded on the scanner glass, select Fax from Glass. When you hear the dial
tone, enter the number by using the keypad on the printer control panel. Follow any prompts that might occur. Your fax is sent when the receiving fax machine
answers. 40 Chapter 6 Fax ENWW Schedule a fax to send later You can schedule a black-and-white fax to be sent within the next 24 hours. This enables you
to send a black-and-white fax late in the evening, when phone lines are not as busy or phone rates are lower, for example.
The printer automatically sends your fax at the specified time. You can only schedule one fax to be sent at a time. You can continue to send faxes normally,
while a fax is scheduled. NOTE: You can only send a black-and-white fax from memory. to schedule a fax from the printer control panel 1.
Load your original print-side up in the ADF. For more information about loading the original, see Load original on page 28. From the Home screen on the
printer display, press the Up and Down buttons to select Fax, and then press OK. select Settings , and then select Schedule a Fax. Enter the fax delay time by
pressing the Up and Down buttons, and then press OK to confirm.
When you hear the dial tone, enter the number by using the keypad on the printer control panel. select Scan , and then select Start. The printer scans all pages
and sends the fax at the scheduled time. From the Home screen on the printer display, press the Up and Down buttons to select Fax, and then press OK. select
Settings , and then select Schedule a Fax. Select the scheduled fax that you want to delete, and then select Delete. Send a fax in Error Correction Mode Error
Correction Mode (ECM) prevents loss of data due to poor phone lines by detecting errors that occur during transmission and automatically requesting
retransmission of the erroneous portion. Phone charges are unaffected, or might even be reduced, on good phone lines. On poor phone lines, ECM increases
sending time and phone charges, but sends the data much more reliably. the default setting is On.
Turn ECM off only if it increases phone charges substantially, and if you can accept poorer quality in exchange for reduced charges. Before turning the ECM
setting off, consider the following. If you turn ECM off: â â â The quality and transmission speed of faxes you send and receive are affected. the Fax
Speed is automatically set to Medium. You can no longer send or receive faxes in color. ENWW Send a fax 41 To change the ECM setting from the control
panel 1. From the Home screen on the printer display, press the Up and Down buttons to select Fax, and then press OK. If you turn off the Auto Answer
option, you must receive faxes manually. If you turn on the Auto Answer option (the default setting), the printer automatically answers incoming calls and
receives faxes after the number of rings that are specified by the Rings to Answer setting. (The default Rings to Answer setting is five rings.
) If you receive a Legal-size or larger fax and the printer is not currently set to use Legal-size paper, the printer reduces the fax so that it fits on the paper that
is loaded. NOTE: If you are copying a document when a fax arrives, the fax is stored in the printer memory until the copying finishes. This can reduce the
number of fax pages stored in memory. Â â â â â Receive a fax manually Reprint received faxes from memory Forward faxes to another
number Set the paper size for received faxes Block unwanted fax numbers Receive a fax manually When you are on the phone, the person you are speaking
with can send you a fax while you are still connected. this is referred to as manual faxing.
Use the instructions in this section to receive a manual fax. NOTE: You can pick up the handset to talk or listen for fax tones. You can receive faxes manually
from a phone that is: â â Directly connected to the printer (on the 2-EXT port) On the same phone line, but not directly connected to the printer To
receive a fax manually 1. Make sure the printer is turned on and you have paper loaded in the main tray. Remove any originals from the ADF tray.
Set the Rings to Answer setting to a high number to allow you to answer the incoming call before the printer answers. Or, turn off the Auto Answer setting so
that the printer does not automatically answer incoming calls. If you are currently on the phone with the sender, instruct the sender to press Send New Fax on
their fax machine. When you hear fax tones from a sending fax machine, do the following: a. b. From the Home screen on the printer display, press the Up
and Down buttons to select Fax, press OK, and then select Receive Fax Manually. After the printer begins to receive the fax, you can hang up the phone or
remain on the line. The phone line is silent during fax transmission.
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ENWW Receive a fax 43 Reprint received faxes from memory The received faxes, which are not printed out, are stored in memory. NOTE: After the memory
becomes full, the printer cannot receive the new fax until you print or delete the faxes from memory.
You might also want to delete the faxes in memory for security or privacy purposes. Depending on the sizes of the faxes in memory, you can reprint up to eight
of the most recently printed faxes, if they are still in memory. For example, you might need to reprint your faxes if you lost the copy of your last printout. To
reprint faxes in memory from the printer control panel 1. Make sure you have paper loaded in the main tray. For more information, see Load media on page
24. From the Home screen on the printer display, press the Up and Down buttons to select Fax, and then press OK. select Settings , and then select Reprint
Missed Faxes. The faxes are displayed in the reverse order from which they were received with the most recently received fax first, and so on. Select the fax
you want to print, and then select Print.
If you want to stop reprinting the fax, select Cancel. Forward faxes to another number You can set up the printer to forward your faxes to another fax number.
a received color fax is forwarded in black and white. HP recommends that you verify the number you are forwarding to is a working fax line. Send a test fax
to make sure the fax machine is able to receive your forwarded faxes.
To forward faxes from the printer control panel 1. From the Home screen on the printer display, press the Up and Down buttons to select Fax, and then press
OK. Select On with Print to print and forward the fax, or select On to forward the fax. NOTE: If the printer is not able to forward the fax to the designated fax
machine (for example, if it is not turned on), the printer prints the fax. If you set up the printer to print error reports for received faxes, it also prints an error
report.
44 Chapter 6 Fax ENWW 5. At the prompt, enter the number of the fax machine intended to receive the forwarded faxes, and then select Done. Enter the
required information for each of the following prompts: start date, start time, end date, and end time. If the printer loses power when fax forwarding is set up,
it saves the fax forwarding setting and phone number. When the power is restored to the printer, the fax forwarding setting is still On. NOTE: You can cancel
fax forwarding by selecting Off from the Fax Forward menu. 6. Set the paper size for received faxes You can select the paper size for received faxes. The
paper size you select should match what is loaded in your main tray. Faxes can be printed on Letter, A4, or Legal paper only.
NOTE: If an incorrect paper size is loaded in the main tray when you receive a fax, the fax does not print and an error message appears on the display. Load
Letter, A4, or Legal paper, and then press OK to print the fax. To set the paper size for received faxes from the printer control panel 1. From the Home screen
on the printer display, press the Up and Down buttons to select Fax, and then press OK. Block unwanted fax numbers If you subscribe to a caller ID service
through your phone provider, you can block specific fax numbers so the printer does not print faxes received from those numbers. When an incoming fax call
is received, the printer compares the number to the list of junk fax numbers to determine if the call should be blocked. If the number matches a number in the
blocked fax numbers list, the fax is not printed. (The maximum number of fax numbers you can block varies by model. ) NOTE: This feature is not supported
in all countries/regions. If it is not supported in your country/ region, Junk Fax Blocker does not appear in the Fax Options or Fax Settings menu.
NOTE: If no phone numbers are added in the Caller ID list, it is assumed that you are not subscribed to a Caller ID service. Â â Add numbers to the
junk fax list Remove numbers from the junk fax list Add numbers to the junk fax list You can block specific numbers by adding them to the junk fax list. To add
a number to the junk fax list 1. 2. From the Home screen on the printer display, press the Up and Down buttons to select Fax, and then press OK.
A message appears stating that Caller ID is required to block junk faxes. To select a fax number to block from the caller ID list, select From Call History. - or
To manually enter a fax number to block, select Enter New Number. 6. After entering a fax number to block, select Done.
NOTE: Make sure you enter the fax number as it appears on the control panel display, and not the fax number that appears on the fax header of the received
fax, as these numbers can be different. Remove numbers from the junk fax list If you no longer want to block a fax number, you can remove a number from
your junk fax list. To remove numbers from the list of junk fax numbers 1. From the Home screen on the printer display, press the Up and Down buttons to
select Fax, and then press OK. select Settings , and then select Junk Fax. Select the number you want to remove, and then select Remove a Number. press OK
to confirm the deletion. 46 Chapter 6 Fax ENWW Set up speed-dial entries You can set up frequently used fax numbers as speed-dial entries. This lets you dial
those numbers quickly by using the printer control panel. TIP: In addition to creating and managing speed-dial entries from the printer's control panel, you
can also use tools available on your computer, such as the HP software included with the printer and the printer's embedded web server (EWS).
This section contains the following topics: â â Set up and change speed-dial entries Delete speed-dial entries Set up and change speed-dial entries You
can store fax numbers as speed-dial entries. From the Home screen on the printer display, press the Up and Down buttons to select Fax, and then press OK.
Type the name of the entry, and then select Next. Type the fax number, and then select Done. NOTE: Be sure to include any pauses or other required numbers,
such as an area code, an access code for numbers outside a PBX system (usually a 9 or 0), or a long-distance prefix. From the Home screen on the printer
display, press the Up and Down buttons to select Fax, and then press OK. select Settings , and then select Phone Book. Select the entry you want to change,
and then press OK. Select Edit, and then make your changes in the fax name, and then select Next. Make your changes in the fax number, and then select
Done.
NOTE: Be sure to include any pauses or other required numbers, such as an area code, an access code for numbers outside a PBX system (usually a 9 or 0),
or a long-distance prefix. From the Home screen on the printer display, press the Up and Down buttons to select Fax, and then press OK. select Settings , and
then select Phone Book. Select the entry you want to delete, and then select Delete to confirm. 48 Chapter 6 Fax ENWW Change fax settings Use the following
steps to change the initial settings or to configure other options for faxing.
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Â â â â â â â â Configure the fax header Set the answer mode (Auto answer) Set the number of rings before answering Change
the answer ring pattern for distinctive ring Set the dial type Set the redial options Set the fax speed Set the fax sound volume Configure the fax header The fax
header prints your name and fax number on the top of every fax you send. HP recommends that you set up the fax header by using the HP software provided
with the printer. You can also set up the fax header from the printer control panel, as described here. NOTE: In some countries/regions, the fax header
information is a legal requirement. From the Home screen on the printer display, press the Up and Down buttons to select Fax, and then press OK.
select Settings , and then select Fax Header. Enter your personal or company name and fax number, and then select Done. Set the answer mode (Auto answer)
The answer mode determines whether the printer answers incoming calls. Â â Turn on the Auto Answer setting if you want the printer to answer faxes
automatically. The printer answers all incoming calls and faxes. Turn off the Auto Answer setting if you want to receive faxes manually. You must be available
to respond in person to the incoming fax call or else the printer does not receive faxes. From the Home screen on the printer display, press the Up and Down
buttons to select Fax, and then press OK. ENWW Change fax settings 49 Set the number of rings before answering If you turn on the Auto Answer setting, you
can specify how many rings occur before incoming calls are automatically answered. The Rings to Answer setting is important if you have an answering
machine on the same phone line as the printer, because you want the answering machine to answer the phone before the printer does.
The number of rings to answer for the printer should be greater than the number of rings to answer for the answering machine. For example, set your
answering machine to a low number of rings and the printer to answer in the maximum number of rings. (The maximum number of rings varies by
country/region. ) In this setup, the answering machine answers the call and the printer monitors the line. If the printer detects fax tones, it receives the fax. If
the call is a voice call, the answering machine records the incoming message. To set the number of rings before answering 1. From the Home screen on the
printer display, press the Up and Down buttons to select Fax, and then press OK. Select up and down arrows to change the number of rings. select OK to
accept the setting.
Change the answer ring pattern for distinctive ring Many phone companies offer a distinctive ring feature that allows you to have several phone numbers on
one phone line. When you subscribe to this service, each number is assigned a different ring pattern. You can set up the printer to answer incoming calls that
have a specific ring pattern. If you connect the printer to a line with distinctive ring, have your telephone company assign one ring pattern to voice calls and
another ring pattern to fax calls. HP recommends that you request double or triple rings for a fax number.
When the printer detects the specified ring pattern, it answers the call and receives the fax. TIP: You can also use the Ring Pattern Detection feature in the
printer's control panel to set distinctive ring. With this feature, the printer recognizes and records the ring pattern of an incoming call and, based on this call,
automatically determines the distinctive ring pattern assigned by your telephone company to fax calls. If you do not have a distinctive ring service, use the
default ring pattern, which is All Rings. NOTE: The printer cannot receive faxes when the main phone number is off the hook.
To change the answer ring pattern for distinctive ring 1. Verify that the printer is set to answer fax calls automatically. From the Home screen on the printer
display, press the Up and Down buttons to select Fax, and then press OK. A message appears stating that this setting should not be changed unless you have
multiple numbers on the same telephone line. select Yes to continue. Do one of the following: â Select the ring pattern assigned by your telephone
company to fax calls. - Or â Select Auto Detect, and then follow the instructions on the printer control panel. NOTE: If the Ring Pattern Detection feature
cannot detect the ring pattern or if you cancel the feature before it finishes, the ring pattern is automatically set to the default, which is All Rings. NOTE: If
you are using a PBX phone system that has different ring patterns for internal and external calls, you must call the fax number from an external number. Set
the dial type Use this procedure to set tone-dialing or pulse-dialing mode.
the factory-set default is Tone. Do not change the setting unless you know that your phone line cannot use tone dialing. NOTE: To set the dial type 1. From
the Home screen on the printer display, press the Up and Down buttons to select Fax, and then press OK. The pulse-dialing option is not available in all
countries/regions. Set the redial options If the printer was unable to send a fax because the receiving fax machine did not answer or was busy, the printer
attempts to redial based on the settings for the busy-redial and no-answer-redial options. Use the following procedure to turn the options on or off. Â â
When Busy: If this option is turned on, the printer redials automatically if it receives a busy signal. The factory-set default for this option is Redial. When No
answer: If this option is turned on, the printer redials automatically if the receiving fax machine does not answer.
The factory-set default for this option is No Redial. From the Home screen on the printer display, press the Up and Down buttons to select Fax, and then press
OK. select Settings , and then select Auto Redial. Select the appropriate option, and then press OK. ENWW Change fax settings 51 Set the fax speed You can
set the fax speed used to communicate between your printer and other fax machines when sending and receiving faxes.
If you use one of the following, setting the fax speed to a slower speed might be required: â â â â An Internet phone service A PBX system Fax
over Internet Protocol (FoIP) An integrated services digital If you experience problems sending and receiving faxes, try using a lower Fax Speed. The
following table provides the available fax speed settings. Fax speed setting Fast Medium Slow Fax speed v. 29 (9600 bps) To set the fax speed 1. From the
Home screen on the printer display, press the Up and Down buttons to select Fax, and then press OK.
Set the fax sound volume Use this procedure to increase or decrease the volume of the fax sounds. To set the fax sound volume 1. From the Home screen on
the printer display, press the Up and Down buttons to select Fax, and then press OK.

You're reading an excerpt. Click here to read official HP OFFICEJET
4630 user guide
http://yourpdfguides.com/dref/5450422

52 Chapter 6 Fax ENWW Fax and digital phone services Many telephone companies provide their customers with digital phone services, such as the
following: â â â â DSL: A Digital subscriber line (DSL) service through your telephone company. (DSL might be called ADSL in your
country/region. ) PBX: A private branch exchange (PBX) phone system. iSDN: An integrated services digital network (ISDN) system. FoIP: A low-cost phone
service that allows you to send and receive faxes with your printer by using the Internet. This method is called Fax over Internet Protocol (FoIP). For more
information, see Fax over Internet Protocol on page 54.
HP printers are designed specifically for use with traditional analog phone services. If you are in a digital phone environment (such as DSL/ADSL, PBX, or
ISDN), you might need to use digital-toanalog filters or converters when setting up the printer for faxing. NOTE: HP does not guarantee that the printer will
be compatible with all digital service lines or providers, in all digital environments, or with all digital-to-analog converters. It is always recommended that
you discuss with the telephone company directly for the correct setup options based on their line services provided. ENWW Fax and digital phone services 53
Fax over Internet Protocol You might be able to subscribe to a low cost phone service that allows you to send and receive faxes with your printer by using the
Internet. This method is called Fax over Internet Protocol (FoIP). You probably use a FoIP service (provided by your telephone company) when you: â
â Dial a special access code along with the fax number, or Have an IP converter box that connects to the Internet and provides analog phone ports for the
fax connection. NOTE: You can only send and receive faxes by connecting a phone cord to the port labeled "1LINE" on the printer. This means that your
connection to the Internet must be done either through a converter box (which supplies regular analog phone jacks for fax connections) or your telephone
company. TIP: Support for traditional fax transmission over any Internet protocol telephone systems are often limited.
If you experience problems faxing, try using a slower fax speed or disabling the fax errorcorrection mode (ECM). However, if you turn off ECM, you cannot
send and receive color faxes. (For more information about changing the fax speed, see Set the fax speed on page 52. For more information about using ECM,
see Send a fax in Error Correction Mode on page 41. If you have questions about Internet faxing, contact your Internet faxing services support department or
your local service provider for further assistance.
54 Chapter 6 Fax ENWW Use reports You can set up the printer to print error reports and confirmation reports automatically for each fax you send and
receive. You can also manually print system reports as required; these reports provide useful system information about the printer. By default, the printer is
set to print a report only if there is a problem sending or receiving a fax. A confirmation message that indicates whether a fax was successfully sent appears
briefly on the control panel display after each transaction. NOTE: If the reports are not legible, you can check the estimated ink levels from the control panel
or the HP software.
NOTE: Ink level alerts and indicators provide estimates for planning purposes only. When you receive a low-ink alert, consider having a replacement
cartridge available to avoid possible printing delays. You do not need to replace the ink cartridges until prompted to do so. NOTE: Ensure that the printheads
and ink cartridges are in good conditions and installed properly. For more information, see Work with cartridges on page 65. This section contains the
following topics: â â â â â Print fax confirmation reports Print and view the fax log Print the details of the last fax transaction Print a Caller
ID Report View the Call History Print fax confirmation reports If you require printed confirmation that your faxes were successfully sent, follow these
instructions to enable fax confirmation before sending any faxes. the default fax confirmation setting is Error Only. NOTE: You can include an image of the
first page of the fax on the Fax Sent Confirmation report if you select After Send Fax or On Always, and if you scan the fax to send from memory or use the
Scan and Fax option. From the Home screen on the printer display, press the Up and Down buttons to select Fax, and then press OK. select Settings , select
Advanced Settings , and then select Fax Confirmation.
Select one of the following options, and then press OK. Off After Send Fax After Receive Fax Does not print a fax confirmation report when you send and
receive faxes successfully. Prints a fax confirmation report for every fax you send. Prints a fax confirmation report for every fax you receive. ENWW Use
reports 55 On Always Error Only Prints a fax confirmation report for every fax you send and receive. prints a fax confirmation report for every fax error.
This is the default setting. Print and view the fax log You can print a log of faxes that have been received and sent by the printer. To print the fax log from the
printer control panel 1. From the Home screen on the printer display, press the Up and Down buttons to select Fax, and then press OK.
Print the details of the last fax transaction The Last Fax Transaction report prints the details of the last fax transaction to occur. Details include the fax
number, number of pages, and the fax status. To print the Last Fax Transaction report 1. From the Home screen on the printer display, press the Up and
Down buttons to select Fax, and then press OK. From the Home screen on the printer display, press the Up and Down buttons to select Fax, and then press
OK.
View the Call History Use the following procedure to print a list of all the calls placed from the printer. From the Home screen on the printer display, press
the Up and Down buttons to select Fax, and then press OK. ENWW Use reports 57 Tips for fax success â Load your original print-side down on the right
front corner of the glass or print-side up in the ADF. For more information about loading the original, see Load original on page 28. Â â Clean the
scanner glass and make sure that there are no foreign materials adhering to it.
turn on Error Correction Mode (ECM) to send color faxes. For more information about turning on ECM, see Send a fax in Error Correction Mode on page
41. Â After the fax memory becomes full, the printer does not receive any faxes until you print or delete the faxes from memory. For more information
about reprinting the faxes in the memory, see Reprint received faxes from memory on page 44. Â You can set up the printer to answer incoming calls with
a specific ring pattern. Use this feature only when you have subscribed to the service, which allows several phone numbers on one phone line from your phone
service provider.
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